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1. Versiones del documento 

 

Version Date Author Version changes 

1.0 11/2021 DBL First version 

2.0 12/2021 DBL Incorporation of new functionalities: 
Users, areas, trees and switchboard events. 

2.1 03/2023 IDP Intercom configuration 
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2. Introduction 

 
The objective of this document is to explain the installation, operation and use of the 

software solution called "GrandStream IP PBX Plugin". 

This solution consists of a plugin that allows you to monitor and interact with the 

physical intercom/public address devices through the Grandstream UCM6510 IP PBX, from the 

user interface and the work environment of the Milestone platform. 

In this way, the monitoring of the intercom/public address system is available together 

with the advantages of the VMS XProtect® for the automatic import of paging groups and 

extensions configured in the Grandstream central, allowing the reproduction of pre-recorded 

messages, the making of live speeches or calls between extensions, as well as the monitoring of 

events and alarms related to the playback of pre-recorded messages and live speeches, SIP 

device status monitoring, all from a single interface. 

https://www.milestonesys.com/


IP PBX GRANDSTREAM UCM63XX Series Plugin - Installation and user 
guide 

5 

 

 

3. Solution architecture 

 
The architecture of the solution is described in the following scheme: 

 

Through the Ethernet network, the plugin connects with the switchboard to 

automatically import the paging groups and the extensions that are configured in the IP PBX 

Grandstream UCM6510. The Grandstream panel must be configured so that communication 

between the Grandstream switchboard and the plugin is possible, and it is possible to make 

status requests from the different extensions. The basic configuration required to work with the 

plugin will be described later in this document. 

Once the communication has been established, the plugin imports the settings related 

to paging groups and extensions. The plugin can initiate communication with the switchboard 

to: 

• Consult the existing paging groups and create the equivalent items in Milestone. 

• Consult the existing extensions and create the equivalent items in Milestone. 
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• Eliminate items in Milestone whose paging group and/or extensions do not exist 

in the intercom/public address center. 

• Send pre-recorded message playback commands 

• Send commands to start live speeches 

• Send call making commands between two extensions 

• Request the status of elements (extensions) 

• Generate events related to extensions whose status is “Available” or 

“Unavailable” 

• Generate events related to the switchboard whose status is “Available” or 

“Unavailable” 

• Import, create and delete locations or areas for extensions 

• Import, create and delete extensions per user 

• Associate extensions with locations or áreas 

• Associate extensions with Milestone users 

• Configure the type of SIP client of each extensión 

• View switchboard states and extensions on the map 

• Monitoring extension states grouped by: 

o Paging group 

o Location or area 
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4. Installation 

 
To install the plugin, simply run the "Grandstream Installer.msi" installer provided by 

SGSE or downloaded from the Milestone Marketplace with administrator permissions. The 

process is automatic. Through the different screens of the installer, we will only have to accept 

the End User License Agreement, a necessary condition to be able to use the plugin. 
 

Click “Next >” to start the installation process. 
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Please read and accept the End User License Agreement to install the plugin. 
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Click “Next >” to continue and install the plugin files. 

If Windows User Account Control is enabled, allow the installer to continue with the 

installation. 
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Once the process is finished, you can press “Close”. The plugin is already installed. 
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5. Licensing 

 
The plugin needs a license to run. Each switchboard and number of extensions must be 

licensed. These licenses are generated by SGSE. The procedure to obtain the license file 

corresponding to the purchased license is described below. 

A. Get the UID 
In order to generate the license file, you will need to provide SGSE with the 

corresponding UID. This UID is a unique identifier that the license is associated with. 

To get this Code, run the XProtect® Management Client after installing the plugin and 

go to the plugin options in the side menu (MIP Plugins > GrandStream IP PBX Plugin). 

On this screen, when the plugin is not licensed, the corresponding UID will appear. 

 

Please provide this UID to SGSE so they can generate your license. 

B. Licence application 
Copy the license file “Licencia.lic” to the plugin directory. The default path is: 

C:\Program Files\Milestone\MIPPlugins\GrandStreamMonitor\ 

After the license is applied, the Event Server needs to be restarted for the changes to 

take effect and you can use the plugin. 
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Once the license is applied, the Management Client interface will display the license 

information: 

 

 

C. Client stations (Smart Client only) 
To obtain the UID on a machine where the XProtect® Management Client configuration 

application is not found and only the Smart Client is available, it will be necessary to use the 

SGSE “UID Generator” tool. 

Consult with SGSE to obtain that tool. 
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6. Configuration 

 
The plugin has been designed to simplify the configuration process as much as possible, 

so that commissioning is as easy as possible for the installer. 

6.1 Plugin configuration 

Register a switchboard 
The procedure to register a switchboard in Milestone is very simple. 

All you have to do is assign a name to the switchboard, to identify it in the system, and 

configure the necessary parameters to allow the plugin to connect to the switchboard via 

Ethernet. The connection is established by the plugin with the Grandstream switchboard 

through some necessary parameters that allow communication to be established; these must 

coincide with the configuration made in the control unit. They are the following: 

• Local IP address / WAN IP address / domain name of the PBX to which the plugin 

has to establish the connection. 

• Local or WAN TCP port of the PBX to which the plugin establishes the 

connection. 

• Username that allows to use the functionality of the switchboard through the 

API. 

• The password of the user that allows to use the functionality of the switchboard 

through the API. 

• Default calling extension. When a Milestone user does not have a configured 

extension, this value will be used as the calling extension. 

The plugin will automatically create in Milestone the items corresponding to the 

switchboard, the paging groups and all the existing extensions in the IP PBX Grandstream 

UCM6510. These items will be accessible from the Management Client interface and from the 

plans in the Smart Client. 

You can see the status of the process in the Milestone MIP logs. 

Default configuration of users and extensions 
The plugin allows the configuration of the association between the users that connect 

to the Smart Client and their extensions to make calls. 

From the Management Client, go to the Tools → Options menu and locate the Property 

tab, then select the User Configuration and SIP Extension tab. 
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Below the listing, it is possible to manually create new mappings between usernames 

and extensions. To do this, you need to enter the values and press the Add button. 

However, there is a faster option and it consists of loading the data through a text file. 

The content of the file must always comply with a configuration pattern that must meet the 

following characteristics: 

• Each line correspond to a user. 

• Username and extension must be separated by the colon character (“:”). 

• Each line must end with the semicolon character (“;”). 

So the appearance of each definition line of the user-extension pair will be: 

<username>:<extension number>; 
 

 
To do this, in the “Load configuration file” section, we will press the Search button and 

locate the configuration file, select it and finally press the Load button. A data update 

confirmation notice will be displayed: 
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Pressing the OK button will load the data from the file. 

NOTE: When loading a file, all previous configurations will be lost and will be overwritten 

by the contents of the file. 

To complete this section, we will press the OK button to close the window. 

Configuration of location areas 
The plugin allows the configuration of areas to visually organize the elements. 

From the Management Client it is necessary to go to the Tools menu → Options and 

locate the Property tab → Location Areas Configuration. 
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On the list, it is possible to manually create new locations. To do this, you need to enter 

the name and click the Add button. 

To complete this section, we will press the OK button to close the window. 
 

 

Paging group types on the map and in the tree 

There are two types of paging group, one for playing pre-recorded messages and the 

other for making live speeches; each of them will be shown with a representative icon on the 

map and in the tree so that the action that the operator can perform from each of them through 

the Smart Client map or from a tree is as clear as possible. 

The available paging group types are as follows: 

• Play pre-recorded messages 

• Give live speeches 
 

Icon Description 

 

Play. Represents the paging group that 
allows the playback of pre-recorded 
messages. 
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Voice. Represents the paging group that 
allows live speeches to be made. 

 
From the tree, through a button, the playback of pre-recorded messages and/or live 

speeches is allowed. In both cases, an event will be generated, and the icons of the extensions 

involved will be updated both in the tree and on the map. 

The following table shows the type of icon associated with each button depending on 

the paging group: 
 

Icon Description 

 Play. Represents the paging group that 
performs the playback of prerecorded 
messages. 

 Microphone. Represents the paging 
group that makes the speech live. 

 

Map and tree extension types 
The plugin allows you to select the type of extension used to play pre-recorded 

messages, make live speeches and make calls between extensions. This will cause the icon of 

the extension to change, however, the action that the operator can perform from each of them 

through the Smart Client map does not change. 

The available extension types are as follows: 

• SIP Phone (by default) 

• Softphone 

• Intercom 

• Speaker 

• Speaker with microphone 

Once an extension is selected, the plugin allows the extension type to be assigned using 

a drop-down list: 
 

Below is the legend with the icon types corresponding to each type of extension: 
 

Icon Description 

 

SIP Phone. Represents the SIP phone 
extension type. 
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 Softphone. Represents the softphone 
extension type. 

 Intercom. Represents the intercom 
extension type. 

 Speaker. Represents the speaker 
extension type. 

 

Speaker with  microphone. 
Represents  the speaker with 
microphone extension type. 

 
Once the extension is configured, the icon associated with the type of extension will be 

displayed on the map and in the tree: 
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Intercom configuration 
For intercom extensions, you can define the connection parameters to enable the option 

of opening the intercom from the map. 

On the Door System Settings > Basic Settings screen of the intercom configuration 

website, the following parameters must be configured: 

• Enable HTTP API Remote Open Door with value “Challenge+Response 
Authentication” 

• Remote PIN to Open Door with a numeric pin to open the door. 

In Milestone, the parameters to be filled are the following: 

• Name of the intercom 

• Extension of type Intercom that corresponds to this configuration. 

• Url address of the intercom, this address is the same one used to configure the 

intercom. 

• Username 

• Password 

• Remote pin, the pin that was specified in the Remote PIN to Open Door option. 

Location configuration 
Once the location areas or zones have been created, the plugin allows their assignment 

to each of the existing extensions through a drop-down menu. If none of the available options 

is selected, the value “Unassigned area” will be assigned: 
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Alarm definition 
This plugin adds some event definitions to Milestone, corresponding to the events that 

are sent from the paging groups for playing pre-recorded messages and from the paging groups 

for live speeches. 

Each event can be defined in Milestone as an alarm. Simply go to the “Alarm Definitions” 

section in the Management Client, create a new alarm whose trigger event is an event from the 

“Grandstream-UCM6510 Events” group, and define the items for which you want this event to 

be considered an alarm. 

Rules: trigger event 
These events can also be used to trigger Milestone rules. To do this, simply create a new 

rule and select one of the events added by the plugin as the trigger event. 

The events currently supported by the GrandStream IP PBX plugin are: 

• Playback of pre-recorded message 

• Live speech 

• Call to Extension (making calls between extensions) 

• Outgoing call from an intercom (pressing an intercom button) 

• Connectivity loss detection with the switchboard 

• Connectivity recovery detection with the switchboard 

• Connectivity loss detection in extensions 

• Connectivity recovery detection in extensions 
 

Rules: actions 
With the actions defined by the plugin, Milestone can interact with the paging groups 

when a certain rule is triggered. 

Rules can trigger the following actions on paging groups: 
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• Play Audio for playback of a pre-recorded message. 

• Play Audio for a live speech. 
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7. Functionality 

 
The “GrandStreamMonitor” plugin allows you to monitor and interact with the physical 

intercom/public address devices (SIP phones, intercoms, softphone, speakers, or speakers with 

microphone) through the Grandstream UCM6510 IP PBX. All interaction is done through the 

standard XProtect® user interface, the Smart Client. 

The operator can send commands to: 

a) Playback groups of pre-recorded messages 

b) Groups of live speeches 

c) Calls between extensions 

A. Event and alarm viewer 
From Milestone's generic alarm and event viewer, you can see and manage the alarms 

and events that arrive from the playback groups and/or live speeches, as well as from those 

extensions that are disconnected from the switchboard. 
 

B. Maps 
The icons corresponding to the switchboards, pre-recorded message playback groups, 

live speech groups and the different types of extensions (SIP phones, intercoms, softphones, 

speakers and speakers with microphone), all of them connected to the Grandstream UCM6510 

IP PBX central can be added to XProtect® maps. 

The icon of each paging group and each extension will show the status of the element 

according to the color legend shown below. 
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The legends corresponding to the different switchboard, paging group and extension 

icons shown on the map are detailed below: 
 

Icon Description 

 Idle. Represents the switchboard when it 
is available (connected). 

 Unavailable. Represents the 
switchboard when it has lost 
connection. 

 Deactivated. Represents the 
switchboard when it is deactivated. 

 

Icon Description 

 Play. Represents the paging group that 
allows the playback of pre-recorded 
messages. 

 Voice. Represents the paging group that 
allows live speeches to be made. 

 

Color Icon Description 

Green 

 

Available. The extension is available and 
there is no problem. 
DeviceOnline events will be triggered 
when the connection is recovered. 
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Orange  In use. The extension is in use. 

Red  Busy. The extension is busy for some 
reason. 

Blue  Ringing. The extension is receiving a 
call. 

Grey 
 

 

Disconnected. The extension is 
disconnected from the exchange. 
DeviceOffline events will be fired. 

Grey  

 

Not available. The extension is not 
available. 

* The same color logic applies to icons associated with other extension types. 

In addition, it allows you to interact with paging groups and extensions through the 

context menu (secondary mouse button). 
 

In this way, it is possible: 

• Map 

o Play pre-recorded messages from a paging group. 

o Make speeches live from a paging group. 

o Make calls between extensions. 

C. Connection status monitoring 
Through Smart Client, the plugin allows monitoring the connectivity status of the 

Grandstream UCM6510 intercom/public address switchboard. 

When the loss of the connection with the switchboard is detected, automatic 

reconnection attempts are made, in the event that connectivity cannot be recovered, an 

"Switchboard Offline" event occurs, the icons of the disconnected switchboard will be displayed 

on the map , the icons of all extensions will turn offline and an “Extension Offline” event will be 
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triggered for each of them. The same will happen with the states of the icons shown in the trees 

and in the list. 

After the recovery of the connection with the switchboard, a "Switchboard Online" 

event will occur, the icons of the connected switchboard will be shown on the map, the icons of 

all the extensions will change to connected and an "Extension online" event will be triggered for 

each of them. The same will happen with the states of the icons shown in the trees and in the 

list. 

D. Side tree “Pre-recorded messages and live speeches” 
Through Smart Client and located at the bottom left of the screen there is a section with 

the title "Pre-recorded messages and live speeches", in it the plugin allows you to display the 

information of the different paging groups and the extensions that are configured in the 

switchboard: 
 

Next to the name of the switchboard, a number is displayed that indicates the number 

of logical levels of grouping of paging groups that are configured in the plugin. In this case, 

between the switchboard and the paging groups there are two intermediate logical levels: 

• Recording Groups: Groups the paging groups that allow the playback of pre- 

recorded messages. 

• Live Groups: Groups the paging groups that allow live speeches to be made. 

Next to the name of the paging group, a number is shown that corresponds to the 

number of extensions that are configured in the switchboard for each of these paging groups. 

In addition, a button is shown that, depending on the type of paging group, allows the playback 

of pre-recorded messages and/or live speeches. 

Once the button associated with each paging group is pressed, the corresponding event 

is generated, the states of all the affected extensions are updated; these state changes will be 

reflected on the map, in all the trees and in the list. 
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Once the playback of the pre-recorded message and/or the live speech is finished, the 

states of the icons of the affected extensions will be updated both on the map and in the 

different trees and in the list. 

E. Tab “Pre-recorded messages and live speeches” 
Through Smart Client and located in the "Pre-recorded messages and live speeches" 

tab, the plugin allows you to display the information of the different paging groups and the 

extensions that are configured in the switchboard. 

This information is displayed by two trees. In each tree, the starting point will always be 

a switchboard type element. Next to the name of the switchboard, a number is displayed that 

informs the user of the number of paging groups that are configured in the switchboard. Next 

to the name of a paging group there is a number that indicates the number of extensions 

assigned to it, and next to it there is a button from which it is possible to play a pre-recorded 

message or a live speech. Under each paging group, the different extensions they have 

configured are shown. 

The tree on the left “Pre-recorded messages” shows the hierarchical organization of the 

paging groups that allow the playback of pre-recorded messages. The tree on the right “Live 

speeches” shows the hierarchical organization of the paging groups that allow live speeches to 

be made: 
 

Once the button associated with each paging group is pressed, the corresponding event 

is generated, the states of all the affected extensions are updated; These state changes will be 

reflected on the map, in all the trees and in the list. 

Once the playback of the pre-recorded message and/or the live speech is finished, the 

states of the icons of the affected extensions will be updated both on the map and in the 

different trees and in the list. 

F. Device status monitoring 
Through Smart Client and located in the "IP PBX Central" tab, the plugin shows the status 

of the different SIP devices, simultaneously informing the user of the logical distribution of 

existing SIP extensions within the areas location. 

The information displayed in this tab can be divided into two sections, a tree structure 

is shown on the left and a list on the right. 
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In the tree on the left, the different paging areas are shown and next to the name of the 

area, the number of configured extensions is shown. Under each of the location areas the 

associated extensions are shown: 
 

 
In the list on the right, all the localization areas are shown and next to the name the 

number of extensions it has is shown. For each location area, the extensions grouped by each 

type of extension are shown. Each extension shows the information corresponding to the type 

of extension and state in which it is located, its name and its extension number: 
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From the list itself, the plugin allows you to establish a call between extensions. This will 

be possible when both are available. To make the call with it will be necessary to press the icon 

of the extension to which you intend to call: 
 

After pressing the button, an event will be generated, and the states of the extensions 

(caller and called) will be updated both on the map and in the different trees and in the list. 

Once the call is finished, the states of the icons of both extensions (caller and called) will 

be updated both on the map and in the different trees and in the list. 

G. WebClient y Milestone Mobile 
These interfaces do not support custom controls or maps, so the interaction from the 

Web Client or the Milestone Mobile app with the Grandstream IP PBX Plugin is limited to 

receiving alarms defined with the plugin events, and to trigger actions with rules (play paging 

groups messages). 
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8. Troubleshooting 

 
Integrated Systems 
In case the integration does not work, please confirm that the Grandstream UCM6510 

IP PBX Intercom/Paging System and its firmware version are compatible with the plugin. Based 

on the control unit manufacturer's documentation, the firmware version must be: 

• FW 1.0.20.30 or later. 

Older firmware versions of the Grandstram UCM6510 IP PBX PBX, please consult your 

Grandstream provider and ask for more information about compatibility. 

The plugin's compatibility has been tested with a Grandstream UCM6510 

intercom/public address center whose firmware version is 1.0.20.30. Compatibility is not 

guaranteed with any older or later firmware version. Although later firmware versions should 

work correctly, compatibility will be subject to specific testing for each firmware version. 

Necessary Equipment 
The Grandstream UCM6510 IP PBX must have an Ethernet connection to be able to 

communicate with the physical devices and with the Milestone plugin. Check with your 

Grandstream provider for more information. 

Others 
• The extension does not establish communication. 

o Check the configuration on the switchboard website. 

o Check the imported settings in Milestone. 

o Check the connection with the physical device. 

• The plugin does not import paging groups and extensions. 

o Check the IP, port, user and password data of the API on the 

Grandstream UCM6510 IP switchboard website. 

o Check the IP address or domain name, port, user and password 

configured in the switchboard. 

• The map shows black circles with white crosses instead of the icons. 

o When the panel is created in Milestone, the items are new in the 

system, so the icons corresponding to the deleted items must be 

removed from the map and added again. 

• Commands don’t work. 

o The state of physical devices or their elements could prevent certain 

commands from being executed. Check the Milestone MIP log for a 

possible error code. 

• In case of Communications failure, try restarting the XProtect® Event Server. 
 

 

More information 
For more information, visit the plugin's online information or contact SGSE at the email 

info@sgse.eu. 

mailto:info@sgse.eu

